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UP-TO-DATE LINKS 
Guidelines: http://hw.oeaw.ac.at/richtlinien 
Document templates: http://hw.oeaw.ac.at/richtlinien/dokumentvorlagen 
 
MultiKey: http://www.oeaw.ac.at/kal/multikey/ 
Classical Text Editor: http://www.oeaw.ac.at/kvk/cte/ 
 
Vademecum: http://hw.oeaw.ac.at/vademecum 
Information for reviewers: http://hw.oeaw.ac.at/vademecum/Merkblatt.pdf 
Manuscipt submission forms: http://hw.oeaw.ac.at/vademecum/Einreichformular.doc 
Citation rules: http://hw.oeaw.ac.at/vademecum/Zitierregeln.pdf 

 
Guidelines for preparing electronic publication in PDF format: http://hw.oeaw.ac.at/ep 
PDF settings: http://hw.oeaw.ac.at/richtlinien/PDF-Einstellungen 
 
Microsoft Office online help: http://office.microsoft.com/de-de/ 
Unicode: http://www.unicode.org/ 
 
Email addresses: 
Contact address for electronic publishing: epub@oeaw.ac.at 
Book production: buchproduktion@oeaw.ac.at 
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1. GENERAL 
In October 2005 the Austrian Academy of Sciences publishing house provided the first 
technically binding guidelines for preparing publications.  As requirements change, e.g. due to 
technical developments, authors’ suggestions etc., every effort is made to update these 
guidelines. 
 
Since Word 2007 the user interface has radically changed due to the introduction of ribbon 
technology. Additionally, many Word commands are now accessed differently. The 2010 / 
2012 versions of Word were also accompanied by optical adaptation of the user interface. 

The “Office button”  has also disappeared. The corresponding commands are now housed 
in the “File” menu. 
 
These significant changes have prompted the publishing house to adapt its document 
templates to the new-look user interface. While the menus in the templates for versions up to 
2007 were located in the “Add-ins” tab, now they are presented in a clear and user-friendly 
fashion in their own ribbon. Since Word 2007 already employs ribbon technology, the new 
document templates can also be used with Word 2007. 
 
 
All information and terms in this edition of the guidelines are based on Word 2010. With a 
few exceptions, the 2012 version’s user interface is identical. These exceptions are shown 
where relevant.  
 Older versions are covered in a separate edition of guidelines. The screenshots were 
created using Windows 10. (There may be some variation between operating systems and 
user-defined settings.) 

1.1 In brief 

1.1.1 Structured text 
These guidelines describe three kinds of structured text preparation: 

• the word processing program Microsoft Word, 
• the XML editor and the 
• classical text editor. 

The basis of every publication is formed by text. 
The most suitable form for the further editing or creation of publications for the 

OeAW is to prepare a “structured text”. 
 
Structured text is characterized by the consistent use of text mark-ups. Throughout the entire 
document the same style and the same XML tag are used e.g. for the first heading level. This 
consistency proves advantageous for further editing, especially in layout programs and online 
systems or databases. 
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1.1.2 Scans/illustrations 
The chapter “Scans/illustrations” provides a general description of the most important criteria 
that should be considered during such operations. 
 
If authors are uncertain, they can still send good-quality templates for scanning or digital data 
and appropriate instructions for further processing. 
 
 

1.1.3 Breaks / layout / PDF for printing / 
PDF online / CD and DVD production 

The book production department is responsible for a publication’s technical production and 
design. 
 Good typography makes the work easier to read and helps make the content 
accessible. Besides print production there are various options for using a book’s data in 
different forms. 
 The data format is determined according to the requirements of each individual case. 
 Experience has proven that use of breaks / layout / PDF for printing / PDF online / CD 
and DVD production without personal consultation with the book production department 
often causes problems. 
 Breaks / layout prove problematic due to the differences between programs, while 
PDF for printing and PDF online have their pitfalls due to rapid technical developments. 
 These elements have been removed from the guidelines in order to guarantee up-to-
date instructions in the short term. 
 
 
 
Book production: 
Robert Püringer, extension 1282 
Elke Salzer, extension 1287 
buchproduktion@oeaw.ac.at 
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2. PREPARING MANUSCRIPTS ON THE BASIS OF 
UNSTRUCTURED TEXTS 

Formally and technically correct data are a prerequisite for a swift and cost-effective 
production process. A key feature of this process is providing support for authors and 
publishers, both informally and technically. 
 The publishing house of the Austrian Academy of Sciences offers various options for 
preparing structured data, with a focus on Word users. 
 

2.1 Document templates with Word 
Document templates with the file type “.dotm” are a specific type of “Microsoft Word 
2010/2012 document” in which inter alia styles, macros, shortcuts and user-defined menu 
bars can be saved. All of these functions are available in a document created using a 
document template. In Word 2010/2012 there are also document templates without macros 
with the file type “.dotx”. 
 
Document templates save authors a lot of work by allowing them to use readymade 
parameters, and they also facilitate adaptation to the later book layout and hence provide huge 
cost savings.  
   
The document templates were tested with the following program versions: 
Windows: Word 2010, Word 2012 

Separate document templates are available for older versions of Word, identifiable by 
the file type “.dot”. 
 
Document template structure 
 

 

Document template 
(file type “.dotm”) 

Macros Shortcuts User-defined menu 
bars 

Styles 

e.g. 
Normal, 

Haupttitel, 
Titel 1, 

Titel 2 etc. 

Font 
 e.g. 
bold, 

italics, 
upper-case, 

letter spacing etc. 

Format templates 
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2.1.2 Where can I find a document template and how do I install it? 
Document templates are available at http://hw.oeaw.ac.at/richtlinien/dokumentvorlagen. 
 
Downloading and saving (example: Varia.dotm) 
To download, click on the link in question using the right mouse button and select “Save as 
...”. 
 
Word saves document template files in a special folder.  There are slight differences between 
Word 2010 and Word 2012 here. 

It is easiest to access the template folder by using system variables, since the path to 
the folder is user-dependent.  
 
For Word 2010 the path name is: 
%appdata%\Microsoft\Templates 
 
This breaks down as: 
C:\Users\<Username>\AppData\Roaming\Microsoft\Templates 
 
 
For Word 2012 the path name is: 
%homepath%\documents\Custom Office Templates 
 
This breaks down as: 
C:\Users\<Username>\Documents\Custom Office Templates 
 
 
In each case <Username> stands for your user name. 
 
Hence you simply enter the path name in the Windows Explorer path box and press the return 
key. 
 

 
 
You then copy the document template to this folder. Copy the help file for the document 
template to the same place. The name of the PDF file must be retained. Then you can activate 
it directly in Word later on.  
 
 
 
 
 

http://hw.oeaw.ac.at/richtlinien/dokumentvorlagen
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Macro Security: Click in the Word options (accessed via the “File” menu) on “Trust Center 
/ Trust Center Settings… / Macro Settings”. In order to be able to use all document template 
functions, please select “Disable all macros except digitally signed macros” and confirm by 
selecting OK. 

The standard template folder is listed under trusted locations (“File / Options / Trust 
Center / Trust Center Settings… / Trusted Locations”). 

All document templates in the standard template folder are thus trusted and a security 
alert will not be shown. 
 
 
If you are not able to access the standard template folder, please contact your system 
administrator or use the “alternative option” for installing document templates:   
Copy the file “Varia.dotm” to the same folder in which your publication is saved. When 
you double-click on the file “Varia.dotm”, a new Word document is created using the 
document template “Varia.dotm”. (Tip: do not open the document template in Word via “File 
/ Open”.) 
 
The disadvantages of this alternative option: 
1. It is not possible to create a new file in Word via “File / New”, and the document template 

is not shown among the “Recently Used Templates” either. 
2. Due to the macros in the document templates, every time you open a file that was not 

created using a document template installed in the standard template folder, the security 
alert “Macros have been disabled” appears. 

 
If you wish to use the macros, click on “File / Options” and install the certificate with 
which the macro projects were signed in the document templates. This saves the certificate 
in the list of “trusted sources” and the security alert will no longer appear.   
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2.1.3a How do I use a document template – Word 2010? 
Once you have copied the document template to the template folder, you can create a new 
document using the document template via “File / New”. 

The new document is linked to the document template and “inherits” all paragraph and 
character formats, macros, the menu bar (ribbon) and shortcuts. 

 
 Click on “File / New” and then on “My templates”. 

In the dialog box “New”, select the document template desired, e.g. “Varia.dotm”. 
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2.1.3b How do I use a document template – Word 2012? 
Once you have copied the document template to the template folder, you can create a new 
document using a document template via “File / New”. 

The new document is linked to the document template and “inherits” all paragraph and 
character formats, macros, the menu bar (ribbon) and shortcuts. 
 
Click on “File / New” and then on “Personal”. 

In the dialog box “New”, select the document template desired, e.g. “varia”. 
 

 
 
 

2.1.4 Styles 
After installing the document template you will find a separate new menu ribbon in the Word 
menu bar: 
 

 
 
The ribbon contains menus for paragraph and character formats, hotkeys and various tools. A 
number of text characteristics (font and font size, indents, spacing etc.) can be established in a 
single step in Word using paragraph and font styles. The individual document templates 
contain a description of each paragraph format, character format and macro. 
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An example of the ribbon in the document template “Varia.dotm”: 
The group “styles” contains two menus for the styles. The character formats are also provided 
as hotkeys for fast clicking. “Styles” shows the format of the character/paragraph currently 
justified. You can display and hide the list of styles using the “Styles” button. 

The “Macros” group contains various tools based on macros. Using the three buttons 
on the far right of the group you can display and hide non-printing characters, e.g. the end of a 
paragraph or tab. Field contents and index entries can also be displayed or hidden here. 
Finally, above right you can find the “Help” button. This opens the help file for the template. 
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As already mentioned, you can display or hide the 
the list of styles using the “Styles” button. 
This can also be done using the shortcut 
[Ctrl] + [Shift] + [Alt] + [S]. 
 
This Word window displays the styles 
alphabetically (as standard) without subdivision. 
You can also assign the most important styles to a 
shortcut. 
These are listed in the individual descriptions of 
the document templates. 
 
Example: 
Titel 1 = [Ctrl] + [1] on the number pad. 
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2.1.5 Editing existing (unstructured) texts 
In principle, the existing document templates are intended for the creation of new text 
documents. 

If however existing (unstructured) texts are to be edited and formatted with the styles 
of a certain document template, the following procedure should be performed: 

• Create a new file via “File / New” with the desired document template (see chapter 
2.1.3) or double click on the desired “.dotm” file if the alternative option for document 
template installation is selected. 

• Insert the existing (unstructured) file into the empty document using “Insert / Text / 
Object / Text from File …”. 

 
The text in the existing file is now inserted into a “new file” and the styles of the desired 
document template (e.g.  “Varia.dotm”) are available. 
 
The desired styles can now be assigned to the individual paragraphs can now be assigned to 
the desired styles using the custom toolbar, the Quick Styles catalogue or the Word window 
“Styles”. See here the description in the chapter “Styles”. 
 
Take care that styles and manual formatting in the existing file are not lost but are accepted 
when you insert the new file.  
 
Removing this manual formatting – assuming it is not desired – and assigning the desired 
styles can sometimes be very time consuming. 
 
Unfortunately, reformatting files in Microsoft Word is a difficult business. Some manual 
formatting can be lost when paragraph styles are assigned. This particularly applies to the font 
“Aisa Unicode”. To solve the problem, there is a macro called “Format Aisa Unicode” in the 
document template “Varia.dotm”. Information on how to use this macro is provided by the 
sample text on the document template “Varia.dotm”. 
 
It is advisable to delete styles imported from the existing document if they are no longer 
required (e.g. “body text”). 
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2.1.6 Document names 
Files must be named in accordance with the rules. The background to the regulated naming of 
files can be seen when continuing to online publications or the server functions implemented 
for that purpose. 
 
Publication of edited volumes or journals: 
“JOEB-55_04-Hoerandne” 
Title of publication        No.*              Author        

 
Books by an author, for instance “Fettweis”: 
“Fettweis_01-Bergbau” 
Author                      No.*        Chapter 

 
* sequential number so that the files are listed in the correct order. 

 
• The following characters are permitted: Latin letters in ASCII character set, 

underscore, hyphen and numbers. The document name may not begin with “0” 
however. 

• Umlauts, letters with accents or special characters ( \ / * ? „ < > | ; .) are not permitted. 

2.1.7 Word settings 
The standard settings for Word are configured to automatically correct typing errors using the 
“AutoCorr” feature. However, this “automatic correction” often has undesired results. 
Therefore automatic replacement of typing errors should be adjusted according to your own 
requirements, and unnecessary options should be deactivated. To do this, click on “File / 
Options / Document Inspector / AutoCorrect Options / AutoCorrect”. 
 

      
 
The settings for “AutoFormat As You Type” should also be adjusted in accordance with your 
own requirements. It is recommended that you disable the options “Automatic bulleted lists”, 
“Automatic numbered lists” and “*Bold* and _italic_ with real formatting”. You should 
definitely disable the option “Define styles based on your formatting”. 
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You should definitely disable the option “Keep track of formatting” under “File / Options / 
Advanced”. 

2.1.8 Fonts 
The use of Unicode fonts is required if print publications are to be turned into fully functional 
online data.  
 
The basic font in the document templates is “Times New Roman”. This font is a Unicode-
compatible font and has a large number of Unicode characters. Also, after MultiKey has been 
installed (see 2.1.10), the font “Aisa Unicode” can be accessed. 
 

There are also different versions of fonts; the number of characters is continually being 
expanded. A new version of the “Times New Roman” font comes with “Windows Vista”. The 
new version contains all Ancient Greek fonts and many Latin characters and accents. 

“Windows Vista” therefore does not need to use the font “Aisa Unicode”. 
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2.1.9 What is Unicode? 
Unicode is an international standard for the digital encoding of the characters or text of all 
known written cultures and writing systems. The aim is to overcome the problem of the 
incompatibility of different codes in different countries. 
 Documents written in Unicode are always compatible, irrespective of country-specific 
settings and operating systems. 
 What are required however are a Unicode-enabled operating system, Unicode-enabled 
applications and Unicode-compatible fonts (http://www.unicode.org/). 

Unicode’s character set has now grown to the extent that it can no longer be 
completely accommodated by a single font. A maximum of 65,536 characters is permitted for 
TrueType and OpenType fonts. Hence just because a font is Unicode-compliant, that does not 
necessarily mean it contains the complete character set; it only means that the selection of 
characters it contains has standard encoding. 

2.1.10 MultiKey 
This tool developed by Dr. Stefan Hagel enables Unicode text to be entered in various 
languages in Microsoft Word and comes with the Unicode font “Aisa Unicode” and a 
conversion tool. 
 Up-to-date information on MultiKey is available at 
http://www.oeaw.ac.at/kal/multikey/. 
 
MultiKey can also be downloaded from this homepage. To install MultiKey, you must be 
registered as an administrator in Windows. If you are not registered as an administrator, 
please contact your system administrator to perform installation. The downloaded file 
“multikey2000.exe” can be launched by double clicking and selecting a folder in which to 
save the MultiKey data. Installation (install.exe) is automatic. MultiKey was installed 
correctly if the red MultiKey symbol appears in the Word ribbon under “Add-ins”. 
 

 
 
If the red MultiKey symbol does not appear, the Office Startup folder was not found during 
automatic installation and you must manually copy the file “MltKey97.dot” to the Startup 
folder as standard. This folder can be found under “C:\Program Files\Microsoft 
Office\OFFICE 12\STARTUP”. 

MultiKey installs the font “Aisa Unicode” with four font styles in the Windows font 
folder. 
 

http://www.oeaw.ac.at/kal/multikey/
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To use MultiKey, you first have to lower the macro security level. In the Word options 
(accessed via the “File” menu), click on “Trust Center / Trust Center Settings… / Macro 
Settings”. Select “Disable all macros except digitally signed macros” and confirm by clicking 
OK. 

Once MultiKey has been correctly installed, whenever Mircrosoft Word is launched 
the security alert “Macros have been disabled”. 

Now click on “Options” and install the certificate with which the macro project was 
signed in the document templates. This allows the certificate to be included in the list of 
“trusted sources” and the security alert will not appear in future. 
 
A brief summary of the most important MultiKey functions: 
F11 switches to the Greek characters (font “Aisa Unicode”), 
F10 switches to the “Latin” characters (font “Times New Roman”). 
F12 shows the MultiKey dialog box with all available fonts. 
Use Ctrl-Shift-Alt-X to turn off MultiKey. 
 

Usage: Letter + modification character = new shortcut, 
e.g.: First “A”, then “+” gives you “Á” 

 
Modification characters 

Latin Greek 
Acute + Acute + or / 
Grave * Grave * or \ 
Circumflex = Circumflex ~ or = 
Tilde ~ or = = Spiritus lenis < 
Diaeresis | (AltGr + „<“) Spiritus asper > 
Caron # Diaeresis # 
 
It is possible that some shortcuts will not work if Windows XP is used and “NumLock” is 
switched on.  If that is the case, temporarily switch off “NumLock”. 
 
The MultiKey conversion tool can be found in Microsoft Word under “Add-ins / 
Menübefehle / Convert font”. 
 

“Windows Vista” users have a new version of the “Times New Roman” font installed and do 
not need to use the “Aisa Unicode” font. 

To switch from “Aisa Unicode” to “Times New Roman” for Greek characters, you need the 
file “MultiKey Preferences” in the MultiKey folder. Open the file and for the option “Use the 
following font for Greek (F11):” select the font “Times New Roman” instead of “Aisa 
Unicode”. 
 
Further information is available in German in the brief instructions (MltKey.doc) and in the 
comprehensive English instructions (Multikey2000.doc), which can be found in the MultiKey 
folder. 
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2.1.11 Some tips on formatting 
To structure a Word document, you have to format the text with styles. We distinguish 
between paragraph styles and font styles.  
When assigning a style to a paragraph, first ensure that the whole paragraph or – as a more 
simple procedure – that nothing in the paragraph is justified. 
 
You have three options for assigning styles: 
 

1. Select a paragraph or font style from the style menus or a character style via the 
shortcuts in the ribbon. 
 

  
 
2. In the ribbon, click on the “Template List” button. The “Styles” window appears to the 

right of screen and you can then assign a style by clicking on it. 

 
 

3. Select a style from the Quick Styles catalogue (indicated by the thumbnails with 
“AaBbCc”) in the “Home” tab in the “Styles” group. 

 
Visually, it makes no difference whether you format your text manually (e.g. with altered font 
attributes, indents and spacing) or simply use the appropriate styles. Formatting is important 
however for the structure and further editing of the data. 
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Before you start work, here are some pointers that are important for further production: 
 
Typographical quotation 
marks 

German „____“ ,____‘ 
English “____” ‘____’ 
French »____« ›____‹ «____» ‹____› Use the correct 
quotation marks, so that there are no complications in the 
processing of your data later on. To this end, please check 
your settings under “Review / Proofing / Set Language” and 
“File / Options / Proofing / AutoCorrect Options / 
AutoCorrect… / AutoFormat As You Type / Replace as you 
type / "Straight quotes" with “smart quotes”” or use the 
function “Insert / Symbols / Symbol”. 

“To” 
(e.g. “pp. 7–10”) 

[Ctrl] + [-] (on the number pad] 

Non-breaking space [Ctrl]+[Shift]+[space bar] 

Blank lines Only add blank lines between paragraphs where they are 
actually necessary. For smaller line spaces, use the paragraph 
style “Standard mit Absatz”. 

Bullets For bulleted lists, e.g. “1.”, “a)”, “●”, “–”, use the designated 
paragraph styles “Aufzählung or “Aufzählung 2” (bullets) 
(for the second tier). Please don’t use Word’s automatic bullet 
points, since they are not adopted properly by most layout 
programs. 

Emphasis bold, italics, small caps, letter spacing, superscript, subscript, 
AllCaps (block capitals). The designated character styles can 
be used for this purpose. Some tips based on practical 
experience: end the formatting before subsequent years in 
small caps. When using superscript or subscript, use 
consistent values (e.g. higher by 3 pt). If upper case is to be 
used for emphasis, do not write the text in upper case, but use 
the character style “AllCaps” or format the text using Ctrl-
Shift-G.   

Tabs When a tab character is inserted using [Tab], Word uses 
certain standard spacings. The default spacing is 1.25 cm – 
that is, the first column begins at 1.25 cm, the second at 2.5 
and so on. These values are usually useless for clean 
formatting. To create lists or other features that require 
indents, define individual tab stops via the dialog box (“Home 
/ Paragraph / Show the Paragraph dialog box (accessed via 
the small arrow below right) / Indents and Spacing”) or by 
using the Word ruler (The ruler bar on the vertical 
ScrollBar). 
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Tables Tables are automatically incorporated with the entire content 
using layout programs such as InDesign, Framemaker or 3B2. 
Using the function “Insert / Tables / Table / Insert Table”, 
you can insert an empty table with the desired number of 
columns and lines. After inserting the empty table, justify the 
entire table (Shift-Alt-Num 5) and assign it the paragraph 
style “Table Text”. If individual cells are centered or other 
changes are necessary, use manual formatting. Select a 
uniform design for the tables. 

Text Boxes  Under no circumstances should you use the option “Insert / 
Text / Text Box”; this applies not only to tables, but in general. 
Text boxes are not recognized by any layout programs! 

Labels/References 
Automatic Table of Contents 
Automatic index 

Many authors use these convenient automatic features in 
Word. Care must be taken however to ensure that automatic 
features are used correctly, especially when creating several 
indices. 

Index entries Index entries are recognized by layout programs, i.e. an index 
can be further edited using InDesign, FrameMaker or 3B2 – 
but only if the index entries exist when the Word document is 
imported. To create index entries: 
– Justify the text that you wish to use as an index entry. 
– Press Alt-Shift-X or select “References / Index / Mark 

Entry”. 
– You can also edit the text in the “Main entry” box 

(sometimes it is necessary to spell a word differently in 
the index than in the text itself) or create a subentry. 

Footnotes / Endnotes Footnotes or endnotes can be added using the command 
“References / Footnotes / Insert Footnote”. The correct 
paragraph and character styles are used automatically here.  
The document templates have integrated macros that insert a 
tab character before and after each footnote or endnote so that 
the formatting is correct. Please use each required macro 
(“Tabs im Fußnotentext einfügen” or “Tabs im Endnotentext 
einfügen”) only once per document, that is, only after 
completing the document, since otherwise additional tab 
characters will be inserted. 
In individual cases you can of course manually insert the tab 
character required. 

Special characters You can use the “MultiKey” tool for texts in foreign 
languages. Individual special characters can be inserted via 
“Insert / Symbols / Symbol”, via the Windows Character Map 
or the keyboard using the Alt code (e.g. Alt-0169 for the 
Copyright symbol). It is important however that you only use 
fonts that correspond to the Unicode standard. When entering 
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Alt codes, hold the “Alt” key down and enter the code on the 
number pad. 

Hyphenation, 
carriage returns 

The option “Page Layout / Page Setup / Hyphenation / 
Automatic” activates hyphenation auto on, the benefits of 
which are only cosmetic however. It is not necessary for 
further editing with layout programs. Please note that manual 
line or page breaks are not necessary and that under no 
circumstances should you use manual hyphens at the end of a 
line. 
 

Show non-printing formatting 
marks 

Use the corresponding buttons in the ribbon to show or hide 
all formatting marks. 
Here you can also show and change the XE fields for index 
entries (e.g.: { XE “Index entry:subentry” }). 

Images/graphs in Word If images or graphs are used in Word, they must be provided 
as separate files. 
Images and graphs should be provided as TIFF or EPS files, 
and color images and graphs should be provided as CMYK 
files, and in the correct size to fulfill the requirements of 
further production, particularly the printing process. 
For further advice, see the chapter “Scans/images”. 

 
 
 
Some final pointers: 
• Files should be named in accordance with the examples provided in chapter 2.1.6 

under “Document names”. 
• The data medium should only have the files required. A brief list should be sent with 

it containing the file names and any notes concerning automatic features used, the 
condition of the images and graphs provided, etc. 

• To be on the safe side, indicate which spelling system you are using. 
 

2.2 XML editors with content management systems 
Encyclopedic or similar texts following the logic of a predefined scheme are suitable 
publications for an XML editor. 

For this kind of publication the specific procedure must be discussed with publishing 
house staff responsible for electronic publications. 
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The files for digital objects (e.g. for individual specialist articles, biographies, geographical 
objects etc.) are formatted in XML so that a website can be uploaded to the server as an online 
encyclopedia. 

The files should be provided as XML 1.0 and the corresponding 
DocumentTypeDefinition or schema (XSD compatible with Word 2003, see also “Microsoft 
Word as an XML Editor”). Additionally, the server requires a style sheet for the server-sided 
HTML transformation for the short, long and media view of each encyclopedia entry. 

 

2.2.1 XML – a brief overview 
XML describes the structure and content of a document. All XML files (including those 
without DTD) must be constructed in accordance with given rules. 
 

1. All elements must be closed afterwards. 
2. Input is case-sensitive. 
3. The elements must be nested correctly. 
4. All XML documents must have a root element. 
5. All values must be in quotation marks. 
6. Several consecutive spaces are not ignored in XML. 

 
The main part of the document consists of the data. They are structured between the tags and 
in the tags as attributes. 
 
A documents definition file (DTD file) describes the structure of an XML document. Here we 
have the individual possible tags and attributes. Moreover, the sequence in which the 
individual elements may appear is precisely arranged. 
 
Formatting is not determined by the XML file. Using XSL, an XML document can be 
converted into another document, especially into HTML format. 
 
Advantages 

• Completely independent from hardware and software 
• Publication of data in different media 
• XML can be used for many applications: as a database, as document management or 

to administrate entries, lists etc. 

2.3 Classical Text Editor 
The program Classical Text Editor (for Microsoft Windows) offers special functions for the 
production of  scientific work: critical apparatus, footnotes, marginalia, line counters, Unicode 
support, MultiKey support, cross references, indices, writing from right to left and many more 
elements. 
http://www.oeaw.ac.at/kvk/cte/ 
 
As in point 2.2, here too you should check with the book production department whether it is 
worth using this fee-based program for your publication. 
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2.4 Microsoft Word as an XML editor 
With the 2003 and later versions of Microsoft Word it is possible to edit XML files in Word. 
If doing so, it is important to use schema files (XSD), which are used as successors to DTD 
files. For further details and templates for using Microsoft Word 2003 as an XML editor for 
the creation of structured electronic publications, please visit http://hw.oeaw.ac.at/ep . 
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3. SCANNING BLACK AND WHITE AND COLOR IMAGES 
Line-/grayscale-/color images 
These templates are usually captured using a scanner. The technical requirements also apply 
to photographs from digital cameras. The quality of the images is determined by three main 
factors: 

1. the scanner/camera (optical, mechanical and electronic components) 
2. the software (scan software, image converter etc.) 
3. the user 

 
The sum of the individual components determines the quality of the final image. This chapter 
outlines the basic requirements for offset printing. Topics such as color management, color 
spaces, image retouching and correction are not covered by these guidelines. There are a 
number of books dealing with these subjects. 
 
Technical requirements for line images 

– Scan resolution of 600 to 800 dpi 
– Size corresponds to intended use in the publication 
– Important: remove dust and scratches 
– Save as: TIF with LZW compression (without loss of data!) 

 
Technical requirements for grayscale images 

– Scan resolution of 300 dpi 
– Minimum 5 percent, maximum 95 percent black (set white point before scanning!) 
– Size corresponds to intended use in the publication 
– Save as: Photoshop-EPS (if compressed, then as a JPEG in maximum quality) or as a 

TIF with LZW compression (without loss of data!) 
– Important: check gray balance of images! 

 
Technical requirements for color images 

– Scan resolution of 300 dpi 
– Size corresponds to intended use in the publication 
– When converting images to CMYK: use separation settings for European offset 

printing: maximum color application 350 percent with a maximum of 95 percent 
black. 

– Save as: Photoshop-EPS (if compressed, then as a JPEG in maximum quality) or as a 
TIF with LZW compression (without loss of data!) 

– Important: image color correction requires color fidelity. This can be achieved either 
by calibrating the monitor, or by checking using color-true proof systems. Commercial 
monitors and printers do not deliver color fidelity
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3.1 Graphs 
Graphs should be created using the appropriate professional programs. The general benefit of 
these programs is that they are able to export or save vector graphs in EPS format 
(Encapsulated PostScript) (e.g. Adobe Illustrator, Macromedia Freehand, CorelDRAW, CAD-
Program etc.). Graphs produced in PowerPoint, Word or Excel always require further 
production; they also suffer from considerable color deviations when converted into printable 
data. 
 
When creating graphs, you should pay particular attention to font size. Fonts in graphs created 
in A 4 format can prove almost illegible when reduced for a 15 × 22.5 cm publication. The 
lines used should not be under 0.3 pt. 
 
Important: 

• Spot colors should only be used when they are also intended for print. 
• Professional graph programs also use different color spaces – please ensure that the 

color space CMYK is used for the document and that all colors are defined in CMYK. 
• Vector graphs – unlike pixel graphs – can be scaled without a loss of quality. 
• Fill patterns from CorelDraw are not accepted by other programs. Pie and bar graphs 

should therefore be produced using grayscale and not color fill. 
• To avoid font problems in graphs, before creating the final graph, create a version in 

which all fonts are converted into paths. This means it is not necessary to provide the 
fonts used and it eliminates potential problems in later production (relating to 
layout/breaks at the printers) from the very outset. 
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Organization of image and graph data 
A significant factor for further editing data is organization. Clear naming and suitable sizes 
and formats can drastically reduce the amount of work required here. 
 
 
RGB data 
While in theory RGB data can be processed by both offset and digital printers due to technical 
settings, in practice they should only be used if there is no other alternative or the entire 
workflow (color management, calibration, ICC profile for the printers and types of paper in 
question) demands it. RGB data are always converted to CMYK for printing; color deviations 
are hence inevitable, since the RGB color space is considerably larger than the CMYK color 
space. 
 You should certainly get in touch with the book production department, even if 
production has already commenced. Tel. +43 1 51581 extensions 1282 and 1287, email: 
buchproduktion@oeaw.ac.at . 
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